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1. Introduction

GIE is offering an API service (Application Programming Interface) on its AGSI+ and ALSI transparency publication platforms
at https://agsi.gie.eu and https://alsi.gie.eu which provides quick, continuous, and direct access to the database and allows you
to filter, create queries and export the data as required. This means that you do not have to set up complex processes to
download files from a remote location, or to crawl through the AGSI+/ALSI web pages to extract the data from the various web
site components. All of this can be directly downloaded, bypassing any web layer, by accessing the available REST APIs.

API Access
The API service is available to the public free of charge.

Registration on the AGSI+ or ALSI website is mandatory for non-data providers to be able to use the API. Registration will
result in a personal API key that is required within the APl URL. The only purpose of this registration is to enable us to assess
and improve the performance of our systems where and if required (user count, user activity, most popular dataset types).

Your account information and settings can be updated (and canceled) at any time after signing in. Your data will be stored and
securely handles if your account remains active.

API access for SSO/LSO data providers

Please note that all SSO / LSO accounts (data providers) using GIE as RRM (Registered Reporting Mechanism) for REMIT
reporting towards ACER or who are providing data for the AGSI+ / ALSI publication can also generate an API key through their
user account at https:/remit.gie.eu/users/profile.

These accounts are already registered at GIE and are also already subscribed to our IT mailing lists (unless you have opted
out).

Data providers can use the same login credentials used for access to the REMIT portal once you have generated an API key in
your REMIT user profile interface. You can opt to have access to solely AGSI+, ALSI or even both.

Currently, APl keys are set to never expire. This might change in the future.
API mailing list
If you would like to be kept up to date on any changes (Service Announcements) on the AGSI+ and ALSI platforms, you can

opt to subscribe to our APl mailing list in the registration form.

Technical implementation
API (Application Programming Interface) provides programmatic access to the data.

API access is provided in a REST-like interface (Representational State Transfer) exposing database resources in a JSON
format. JSONP is currently not supported but is foreseen in the future to also allow for cross domain requests.

Additional documentation, examples, and guidance on how to use and implement the API service is provided below.

V4 is still applicable for ALSI. This will be changed soon in a later version


https://remit.gie.eu/users/profile

Data coverage

Daily storage and LNG data reporting
Only the daily storage and LNG data reporting as currently available on the platforms is made available. Unavailability reporting
is currently not (yet) part of the API coverage.

Aggregated datasets
Both individual facility datasets and aggregated datasets (by company and country level) are available. Aggregated datasets
are to be exported using the additional REST API parameters (see below).

Storage facilities and Storage Groups

Note that for storage data, a dataset can be either an individual storage facility, or a storage group (virtual storage) which is
comprised of multiple storage facilities. The composition of a storage group can evolve and change over time (any changes
will be reported through a Service Announcement).

(Storage) Facility Operators
Note that storage facilities can change ownership, which will result in the facility dataset being assigned to another SSO. Any
such changes are reported through the Service Announcements.

Historical data usage (timeframe)

¢ new facilities and decommissioning
If a new (storage) facility comes online, or when a (storage) facility is being decommissioned or shut down, the related
dataset start/end date is to be considered. Any such information is also reported through a Service Announcement,
as it has an impact on the historical (aggregated) dataset coverage. Historical data for facilities that have changed
ownership, or have been decommissioned or shut down, remains available through a dedicated separate code
(typically starting with PRIOR).

e historical data range
Historical data has been requested from all SSO/LSO publishing on AGSI+/ALSI for the following timeframe:

o  On AGSI+: historical data since 01/01/2011 or since the date the storage facility has become operational
and/or until the storage facility has been decommissioned or changed ownership.

o  On ALSI: historical data since 01/01/2012 or since the date the LNG terminal has become operational

e Historical data coverage
Additionally, note that on AGSI+ not all SSO have been able to provide the full historical data coverage. Some SSO
only provide historical data since the start of REMIT reporting (07/04/2016). A detailed data overview is available at
https://agsi.gie.eu/data-definition.



https://agsi.gie.eu/data-definition

2. Data field library

2.1EIC listing

/api/about?show=listing

Field identifier | Descripton _________________________________________|Datatype _______|

name Name of the company string
short_name Short name of the company string
type Type of the company string
eic EIC of the company string (EIC)
country Slug (code) of the country string (2 characters)
url URL to get the data through API URL
facilities Array of underlying facilities array
name Name of the underlying facilities string
type Type of the facility string
eic EIC of the facility string (EIC)
country Slug (code) of the country string (2 characters)
company Company EIC code string (EIC)
url URL to get the data through API URL
[
-1
name: “asztora GmbH",
short_name: “astora”,
type: “ss07,
eic: "21Xpeeens201160]",
country: "AT",
url: "https://agsi.gie.eufapi?country=ATEcompany=21Xa22000881150]1",
- facilities: [
-1
name: UG5 Haidach (astora)”,
type: “Storage Facility”,
eic: "21We80000088873N",
country: "AT",
company: "Z1X@eoooasellsal",
url: "https://agsi.gie.csufapi?country=AT&company=21Xaee00a08115618Tacility=21U0ca00000887 2N"
}
1
I
-1

name: “GSA LLCT,

zhart nams: "roa”



For more information, or a hierarchical listing, omit the “?show=listing’ parameter:

/api/about

Field identifier

company_type
type
country
image
short_name
name
url
eic
facilities
eic
name
country
code
name
type
data
type
country
code
name
code
name

- 550: {
- Europe: {
- Austria:

-1

Type of the underlying companies (SSO, LSO, TSO) string

Europe / Non-Europe string

Name of the country string

base64 encoded image (logo) string (base64 encoded)
Short name of the company string

Name of the company string

URL of the company’s website URL

EIC of the company string (EIC)

Array of facilities array

EIC of the facility string (EIC)

Name of the facility string

Array with facility’s country data array

Country code string (2 characters)
Name of the country string

Facility type string

Data array with more information array

Company type (SSO, LSO, TSO) string

Array with company’s country data array

Country code string (2 characters)
Country name string

Europe (EU) / Non-Europe (NE) string (2 characters)
Europe / Non-Europe string

[

image:
"iUEORuB(GgoAﬁﬁANSUhELgAAAIuAAAA:CAVAAAB:XDCeﬁﬁﬁAGXRFNFR_bZZSdZFyZQBBZGEiESBjsthZV]lYNRSc:llPA&
short_name: "astora”,

name: “"sstora GmbH",

url: "http://www.astors.de”,

eic: "21Xeeeseeedlleel",

- facilities: [

¢ eic: "21NeaeaLenoaa7sN",
name: "UGS Haidach (astora)”,
- country: {
code: "AT",
name: “Austria”
I
type: "Storage Facility”
}
1

- data: {

type: "ss07,
- country: {
code: "AT",
name: "Austria”
I
code: "EU",
name: “Europe”

======



2.2News listing

/api/news

Field identifier Data type | Example |

Amount of pages available for the

last_page numeric 25
query
Amount of data entries for the .
total numeric 30
page
data Array of data entries array
url String to get the specific news item  string 4581
start_at Start of when the service datetime 2022-04-21 10:45:00
announcement is taking place.
End of when the service
end_at announcement is taking place. Null  datetime / null null
if not applicable.
title Title of the service announcement string Update for data platforms
summa Summary of the service strin There will be an update for the data
y announcement 9 platforms on April 21, 2022
. Details of the service Just some more details on the service
details text
announcement announcement. Usually a longer text.
1 -Source O
- data: [
-1

url: "4581",

start_at: "2822-@4-21 10:45:08",

end_at: null,

title: "EWE - Reporting end for dataset EIC 21W08E20080081867 - UGS Nittermoor L GUD as of 21 April 28227,

summary: "

details: "<p»EWE is ending its reporting for dataset EIC 21W9000088001867 - UGS Nittermoor L GUD as of 21 April 2822.<br>Historical data will remain
available.</p»<p>cfr. earlier announcement:<br>As of 1.4.2022, the capacities of the "UGS EWE-Zone L¥ (21W@@02200801075) with connection to the
transmission system of GTG MNord and the capacities of “<span style="background-color: initial;"»UGS Nittermoor L GUD" (21WP028202021067) with
connection to the transmission system of Gasunie Deutschland will be aggregated under the “UGS EWE-Zone L* (21W@80000081875).</span></p>"

url: "4582",

start_at: "2822-04-21 @3:88:00",

end_at: null,

title: "Ukrainian dataset available again - covering aggregation of all storage facilities",

summary :

Add the URL parameter to get a specific item.
/api/news?turl=4581

{

- data: [
-1

-Source Onli

url: "4531",

start_at: "2822-04-21 1@:45:08",

end_at: null,

title: "EWE - Reporting end for dataset EIC 21We080e@@001a67 - UGS Nittermoor L GUD as of 21 April 28227,

summary: "<p>EWE - Reporting end for dataset EIC 211@00000@8281067 - UGS Nittermoor L GUD as of 21 April 2022</p>",

details: "<p>»EWE is ending its reporting for dataset EIC 21weeee@eeeel@s? - UGS NUuttermoor L GUD as of 21 April 2622.<br>Historical data will remain
available.</p><p>cfr. earlier announcement:<br>As of 1.4.2822, the capacities of the "“UGS EWE-Zone L™ (21W8000008801075) with connection to the
transmission system of GTG Nord and the capacities of “<span style="background-color: initial;"»UGS Nittermoor L GUD™ (21W000020001067) with
connection to the transmission system of Gasunie Deutschland will be aggregated under the UGS EWE-Zone L¥ (2110069000001875).</span></p»"



The following data fields are published on AGSI+:

2.3AGSI+
- Facility Report listing
/api

Field identifier [ Description ____________| Datatype ___[Example

last_page

total

dataset

gas_day

data
name
code

{consumption}
{consumptionFull}
url

gasDayStart

gasinStorage

injection

withdrawal

workingGasVolume

injectionCapacity
withdrawalCapacity

status

trend
full

info

Amount of pages available for the

query

Amount of data entries for the

page

Breadcrumb for the dataset
The current Gas Day Start date

Array of data entries
Name of the data entry

The code or EIC of the data entry
{optional} Consumption level, only
for countries (4 digits accuracy)
{optional} Consumption full, only

for countries

The portion used in the URL on
AGSI+/ALSI for direct linking
The start of the gas day reported

upon

Total amount of gas in storage at
the facility, status at end of gas

day (4 digits accuracy)

Injection during gas day (2 digits

accuracy)

Withdrawal during gas day (2

digits accuracy)

Maximum amount that can be
stored at the facility (technical
capacity) (4 digits accuracy)
Maximum technical injection
capacity (2 digits accuracy)
Maximum technical withdrawal
capacity (2 digits accuracy)

E (estimated) C (confirmed) N (no

data)

injection - withdrawal)/ WGV

Storage / WGV (in%)

Service Announcement (if

applicable)

numeric

numeric

URL
date
array
string
string

TWh
%
string
date

TWh

GWh/d

GWh/d

TWh

GWh/d
GWh/d

E/C/N

+ /-
%

array

25

30

<a href="/historical/eu">EU</a> > DE
2022-04-04

Germany
DE

995.2753
6.44
21Z0000000002710/DE/21X000000001160J

2015-11-02

853.4219

238.66

2182.49

1022.7059

9973.17
17599.82

Cc

-0.1
83.45



- Unavailability Report listing

/api/unavailability

Field identifier [ Description | Datatyjpe [ Example ____________________|

last_page

total

data
published
country
SSO
facility

start
end

volume
injection
withdrawal

description

end_flag

type

Amount of pages available for the
query

Amount of data entries for the
page

Array of data entries

Publish datetime of the data entry
Name of the country

Name of the reporting SSO
Name of the reporting facility

Start of the unavailability

End of the unavailability
Unavailable volume (3 digits
accuracy)

Unavailable injection (1 digit
accuracy)

Unavailable withdrawal (1 digit
accuracy)

Description of the unavailability

Estimated or Confirmed

Planned or Unplanned

numeric

numeric

array
datetime
string
string
string
datetime

datetime

TWh
GWh/d

GWh/d

text
Estimated /
Confirmed
Planned /
Unplanned

25

30

2022-04-21 09:59:51
Germany

Uniper Energy Storage
UGS Bierwang

2022-04-20 09:00:00
2022-04-20 18:00:00
0.000

0.0

0.0
Maintenance on presser valve.

Confirmed

Planned



The following data fields are published on ALSI:

2.4ALSI
- Facility Report listing
Field identifier Data type | Example

TO BE DETERMINED



3. Data

3.1Data quality indicators

The data quality status (Estimated/Confirmed/No Data) is part of the available datasets, as well as the Service Announcements (SA)
linked to each dataset.

Any applicable Service Announcements are available through the info data field as an URL linking to the related news item.

3.2Dataset identification
Each storage system operator (SSO) and LNG terminal operator (LSO) and its listed facilities are identified using EIC codes.

The datasets are identified using the EIC codes as used for REMIT reporting and/or used for data provision to GIE for those SSO/LSO
not using GIE as RRM (Registered Reporting Mechanism) for REMIT or for SSO/LSO not falling under the REMIT regulation.

The mapping table for these EIC codes is available at (after login).

Please note that the EIC code database is subject to updates and EIC codes used on AGSI+ or ALSI can change over time. For
example: Facilities can change operator, new facilities can become operational or be decommissioned, a facility can be moved within a
(virtual) storage group and change code, etc.

The EIC codebase is expected to be updated further in accordance with REMIT regulation (using only ACER approved EIC codes where
applicable).

If such changes would have occurred, we will be able to inform you through the API mailing list.

3.3Units of Measurement and data definitions

Additional information on units of measurement and specific data definitions are available at: https://agsi.gie.eu/data-definition

3.4Data updates - publication timing and processing

The data is available in daily frequency and represents gas in Storage / LNG at the end of the previous gas day. Data is updated every
day at 19:30 CET and a second time at 23:00. Some SSO/LSO are not able to provide their data before 19:30 but these will be included
in the second publication time.

4. Assistance

4.1Technical assistance (API)

Any technical inquiries related to the implementation of the API service can be addressed to api@gie.eu. Our IT team will be happy to
assist you.

4.2Data clarification

Any inquiries on data published through AGSI+ / ALSI can be addressed to transparency@gie.eu. Note that for inquiries related to a
specific SSO or LSO, the operator may need to be contacted directly, as GIE cannot speak on their behalf.

AGSI+ / ALSI offers you the possibility to be kept up to date whenever a new Service Announcement or update from one of our data
providers is posted on the website. Please provide your contact details using the subscription form, and you will be informed by e-mail
whenever news or updates are made available.

AGSI+: https://agsi.gie.eu/subscribe

GIE is also providing additional related data such as the Storage Map, LNG Map and Storage and LNG Investment Database at
http://www.gie.eu/maps-data/

5. Disclaimer

All data is provided by the contributors on a voluntary basis and free of charge. The Data provided by AGSI+ / ALSlI is for information
only. GIE is using reasonable efforts to invest in ensuring the correctness, completeness, and timeliness of the information provided
herein. Data have been carefully checked, are updated at regular intervals and may be subject to changes, removal, or amendments
without prior notice.

GIE neither assumes any warranty or liability for the correctness and completeness of information/services and entries nor for the mode
of presentation.


https://agsi.gie.eu/data-definition
http://www.gie.eu/maps-data/

6. Tutorial

6.1Account setup

Will be available soon.

6.2API page

Will be available soon.

6.3EIC code mapping

Will be available soon.



6.4Importing data - cURL
Using the links from the previous pages and your API key, you can send requests to the

API to get the data in JSON format:

curl https://agsi.gie.eu/api?type=eu --header "x-key: YOUR API KEY"
{"last_page":159,"total":30,"dataset":"EU", "gas day":"2022-04-

19", "data": [{"name":"EU", "code":"eu", "url":"eu", "gasDayStart":"2022-04-

19", "gasInStorage":"326.9226", "consumption":"4151.8372", "consumptionFull":"7.87","injection":

If the API key is not supplied or incorrect, no data is returned.

To automatically loop over the API results, a bash file is needed. We cannot support this much further.

6.5Importing data - Excel
To access the data from an external source, you need to send the x-key as a parameter in your header.

When using Excel, you can import the data using the following code snippet. By changing the URL and parameters, you can finetune it
to your needs. This example uses the paging logic present in APl V2.

Steps are as follows:

1 — Create a new workbook (or tab) and go to Data > Get Data > Launch Power Query Editor.

[ fa [BFromText/CSV  [B Recent 5
Get [® From Web [B Existing 1
Data~ | B3 From Table/Ranae

D From File >
4
[‘F:] From Database >

& From Azure >

9

|:‘gl From Other Sources >

g‘ﬁ Combine Queries >

@ Launch Power Query Editor...

[T BN T R S TP (S

10 [§ Data Source Settings...
1
12 Cuery Options
13

2 — Right click underneath ‘Queries’ and choose New Query > Other Sources > Blank Query

Queries [0] <
NewQuery — » |7 File »
MNew Group... Database >
A Azure 3
'(:2- Other Sources P B Web
Combine N OData feed
ODBC
Dq Recent Sources 3 ¢-
- - OLEDB
£ Blank Query




3 — When the new blank query is created, click on Advanced Editor:

~ EE'DProperties
= e i
= T Advanced Editor

Close & Refresh Choose Remove Keep Remc
Load~  Preview~ [Z] Manage = Columns = Columns Rows -~ Row:
Close Query Manage Columns Reduce Row

< il

4 — Copy paste (and edit where needed) the query provided below in the opened Editor:

e JR—— R et e ouis S

= K3l Advanced Editor O X
Query1 isplay Options = @
let

Pagination = List.Skip(
List.Generate( () => [
IsHore = null,
Last_Key = 8,
Counter = 1
1, // Start Value
each [IsMore] <> false,// Whilst this is true, keep going
each [Bren = Json.Document(keb.Contents("nttps://agsi.gie.eusapiztype=eussize=360" & "&page=" & Text.From([Counter]), [Headers=[#"x-k
Last_Key = if[Counter] = 1 then Bron[last_page]+1 else [Last_Keyl,
Counter = [Counter]+1,
IsMore = if [Counter] < Last_Key then true else false,
data = Bron[data],
Table = Table.FromRecords(data)

1
each [Table] // selector
) L1,
#"Table from list" = Table.FromList(Pagination, Splitter.SplitBydothing(}, null, null, ExtraValues.Error),
#"Columnl expanded” = Table.ExpandTableColumn(#"Table from list”, "Columnl”, {"name”, "gasDayStart”, "gasInStorage”, “"consumption”, "cons|

#"Columnl expanded”

/' No syntax errors have been detected.

Done Cancel

The highlighted code can be changed without causing the pagination to break (YOUR_API_KEY has to be changed into your actual key
otherwise it won’t fetch any data).

let
Pagination = List.Skip(
List.Generate( () => [
IsMore = null,
Last Key = 0,
Counter =1
1, // Start Value
each [IsMore] <> false,// Whilst this is true, keep going
each [Bron = Json.Document (Web.Contents ("https://agsi.gie.eu/api?type=eu&size=300" & "&page=" &
Text.From([Counter]), [Headers=[#"x-key"="YOUR API KEY"]])),// retrieve results per call
Last Key = if[Counter] = 1 then Bron[last page]+l else [Last Key],
Counter = [Counter]+1,
IsMore = if [Counter] < Last Key then true else false,
data = Bron[datal,
Table = Table.FromRecords (data)
1,
each [Table] // selector
) 1),
#"Table from list"™ = Table.FromList (Pagination, Splitter.SplitByNothing(), null, null, ExtraValues.Error),
#"Columnl expanded" = Table.ExpandTableColumn (#"Table from list", "Columnl", {"name", "gasDayStart",
"gasInStorage", "consumption", "consumptionFull", "injection", "withdrawal", "workingGasVolume",
"injectionCapacity", "withdrawalCapacity", "status", "trend", "full"}, {"name", "gasDayStart", "gasInStorage",
"consumption", "consumptionFull", "injection", "withdrawal", "workingGasVolume", "injectionCapacity",
"withdrawalCapacity", "status", "trend", "full"})
in

#"Columnl expanded"



5 — Click on Done and Close & Load and let Excel load all the data. Depending on the request, this can take a short while.

I
& |
Close &| Rt
Load - Pre

Close

The same query can be used for Power Bl. We cannot support this much further.

6.6lllustrative example using a browser
To extract data from the system, you can click on one of these links:

AGSI+ https://agsi.gie.eu/api?type=eu

Click “Save As” to download the file. You have just downloaded the values from website.

The above URLs are illustrating that an API (Application Program Interface) can be used as nothing more than a Web address. When
you entered this web address in your browser, the browser retrieves the data you want, just like it would access a web site. The result
can be either viewed within the browser or saved as a file on your computer.

JSON web browser plugins

You can use a JSON formatter browser plugin to see the data call results directly in your browser.


https://agsi.gie.eu/api?type=eu

7. REST APl Parameters

A REST API enables you to filter the data by adding parameters directly to the Web address, where other systems would require you to
go through a series of forms or web pages.

Below are some examples on how these can be used:

Accepted value(s

page Number of the page you want to get the data from. Starts from number 1 positive numeric value
reverse Reverse the data return true /false /0 /1
size Amount of data entries per page. Default is 30, max accepted value is 300 positive numeric value
from Start Gas Day Start date date
to End Gas Day Start date date
date Specific Gas Day Start date date
type Facility reports: Europe, Non-EU or Additional Information data entries EU/NE/AI
Unavailability reports: Unplanned / Planned Unplanned / Planned
end_flag Unavailability reports only: Filter on end flag type confirmed / estimate
country Country code ex: DE
company Company EIC code, must be used with the company’s country code and country EIC
parameter ex: 21X000000001160J
facility Facility EIC code, must be used with the country and company codes and EIC
country/company parameters ex: 21W000000000081Y

The correct way to use these parameters is by adding them to the URL as query string parameters / URL variables:
Examples:

/api?country=de&date=2022-03-31
{

last_page: 1,

total: 1,

dataset: "<a href="/historical/eu">EU</a> > DE™,
gas_day: "2022-04-94",

- data: {
name: "Germany”,
code: "DE",

consumption: "995,2735",
consumptionFull: "6.33",

url: "DE",

gasDayStart: "2022-83-31",
gasInStorage: "63,9463"7,
injection: “S63,62",
withdrawal: "521,29",
workingGasVolume: "243,4311",
injectionCapacity: "3943,93",
withdrawalCapacity: "6724,93",
status: "C",

trend: "-8.81",

full: "26.27",

info:[]



/api?facility=212000000000102A&country=BE&company=21X-BE-A-AOAOA-Y &from=2022-03-06&t0=2022-04-04&page=1&size=30
1

last_page: 1,

total: 3@,

dataset: "<a href="/historical/eu">EU</a> > <a href="/historical/BE">BE</a> » <a href="/historical/21X-BE-A-ABABA-Y/BE">Fluxys</a> > UGS Loenhout”,
gas_day: "2022-04-04",

- data: [
- {
name: "UGS Loenhout™,
code: “217Z@@eee00@8l024",
url: "217080000008102A/BE/21X-BE-A-ARABA-Y",
gasDayStart: "2022-24-84",
gasInStorage: "1,3399",
injection: “4,37",
withdrawal: "@,00",
workingGasVolume: "2,8098",
injectionCapacity: "83,14",
withdrawalCapacity: "135,68",
status: "E",
trend: "@.85",
full: "14.87",
info:[]
I
-1
name: "UG5 Loenhout™,
code: “217Z@@eee00@8l024",
url: "217666600008162A/BE/21X-BE-A-ABABA-Y",
gasDayStart: "2022-24-83",
gasInStorage: "1,3355",
injection: “4,37",
withdrawal: "@,00",
workingGasVolume: "2,8098",
injectionCapacity: "83,14",
withdrawalCapacity: "135,68",
status: "C",
trend: "8.85",
full: "14.82",
info:[]
T
-1

name: "UGS Loenhout™,

code: "2170800080881024",

url: "217000000008102A/BE/21X-BE-A-ABAGA-Y",
gasDayStart: "2022-84-82",

Omitting the ‘from’ and ‘to’ parameters will get results from the start of reporting entries until the current GasDayStart.
Note:

e To get data from EU/NE/AI, you use the ‘type’ parameter;
/api?type=eu&date=2022-03-31

e To get data from a country, you use the ‘country’ parameter;
/api?country=de&date=2022-03-31

e To get data from a company, you need to use both the ‘country’ and ‘company’ parameter
/api?country=de&company=21X000000001160J&date=2022-03-31

e To get data from a facility, you need to use the ‘country’, ‘company’ and ‘facility’ parameters
/api?country=de&company=21X000000001160J&facility=2120000000002710&date=2022-03-31



7.2Pagination

A lot of the time, when making calls to the API, there'll be a lot of results to return. For that reason, we paginate the results to make sure
responses are easier to handle. Therefore, each API call returns an ‘last_page’ parameter so your program will know how long to loop
over the results to get all the data. There is a default limit on results (30 per page), but we recommend you always explicitly set the
‘size’ parameter to ensure you know how many results per page you'll get. Of course, the number of records on the last page can vary.
Do note that the ‘size’ is capped at 300.

¢ last_page: 159,
total: 3@,
dataset: "EU",
gas_day: "2@22-84-12",

- data: [

{

url: "eu",
gasDayStart: "20822-84-19",
casTnStorase: "3I06 02287

As you can see in the example above (API call: https://agsi.gie.eu/api?continent=EU&page=1&size=30), there are 159 pages to loop
over. Increasing the size, will decrease the number of pages:

{
last_page: 16,
total: 388,
dataset: "EU",
gas_day: "2022-24-19",
- data: |
-1
name: “EU",
code: "eu",
url: "eu",
gasDayStart: "2022-24-197,

7.3Rate limiting

To ensure data quality and timely access to our APl and website, we enabled rate limiting on API calls. Rate limiting is used for limiting
network traffic as it puts a cap on how often someone can repeat an action within a certain timeframe and can help stop certain kinds of
malicious bot activity.

Any API account that exceeds 60 API calls per minute will automatically be put in a waiting queue and get a 'too many requests' error
message for a duration of 60 seconds, each time. We will also monitor the accounts in this queue and if data calls are not adjusted
properly and timely, we will affect a permanent ban on these accounts, by placing these accounts on our blacklist as 'DDOS attack’
users.

These measures are intended and required to assure operational reliability and an effective and performant system to our complete
userbase. Calling the API excessively is pointless as our AGSI+ and ALSI transparency platforms only process and publish new data
ONCE a day at 19:30 publication time.

As each pull of a new page is considered a new API call, consider building in a delay of data pulling should your system go over the 60
calls per minute threshold.

The rate limiting is based on tracking the IP addresses that requests are coming from and tracking how much time elapses between
each request. It measures the amount of time between each request from each IP address and the number of requests within a
specified timeframe. If there are too many requests from a single IP within the given timeframe, the rate limiting solution will not fulfill the
IP address's requests for the next 60 seconds.


https://agsi.gie.eu/api?continent=EU&page=1&size=30

8. FAQ

e Can you help with our requests in jQuery/PHP/cURL/Python/Excel/PowerBI...?
We can not support programming related questions, but we’ll always try to help to the best of our abilities.

¢ The displayed data is incorrect, can you fix it
We do not alter data send in by the SSO/LSO. Unless it is a programmatic related error (double counts for instance), we can
only relay the issue back to the SSO/LSO in question and wait for them to update their data.



9. Document versions

V001
March 2018 — First release

V002
September 2018 — Removal of completeness data field as it is considered obsolete by GIE.

V003
October 2018 — Change of APl URLs to accommodate facilities with duplicate EIC codes, belonging to different companies in the same

country.

V004
October 2019 — Addition of Excel tutorial and small document changes; chapters, repositioning text blocks

V005
April 2022 — V2 of the API for AGSI+ only. New API calls for AGSI+, ALSI will be changed soon as well. Missing chapters will be added

soon, please use V4 for these.

V006
April 2022 - V2 further explained with working example code for Excel. Added FAQ
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